
Adobe Illustrator 3.0 Lea Bromley
It has not been very long since I started reviewing software for AMUG and the Newsletter. Adobe Illustrator 3.0 is 
the most exciting assignment  (and perhaps the most challenging) I have attempted. I have used Illustrator 88 solely
to edit and revise disk labels on the Best of... software, and have made only occasional forays into creating anything 
original. So I am a real novice with any serious drawing programs. The other inexperienced souls out there will 
probably appreciate this, but the experienced or professional users may find their questions unanswered. Please do 
not hesitate to contact me at the Best of... table or call 838-4036 and I will try to find answers to your questions.

Getting started, I worked my way through the tutorial, skimmed through the Reference Manual, Color Guide 
and “Beyond the Basics” booklet. I hunted through all my Mac magazines (MacWorld, Publish and MacUser), 
catalogs (MacWarehouse and MacConnection) and newsletters (Step-by-Step Electronic Design, and Before & After)
for articles about 3.0. I even borrowed a magazine (Personal Publishing) in my search for information. According to
Personal Publishing, Illustrator 3.0 “makes forays into the realms of page-layout and presentation graphics.” 
Kathleen Tinkel of Step-by-Step Electronic Design is very complimentary in her November 1990 review, saying the 
“the new Illustrator 3 feels as if it were designed by and for graphic artists.”

Adobe lists the following as New Features: The new type tools let you enter text directly on-screen. With these 
new tools, text objects can be created with an almost unlimited number of characters. Type can be imported in 
several formats and you can also combine any mixture of type faces, sizes, styles, and colors in a text object. The 
type tools let you control tracking, kerning, word and letter spacing, horizontal scaling of characters, vertical shift 
for superscripts and subscripts, justification and hyphenation. Type can be placed on a curve and used to fill 
irregularly shaped objects. The program has the ability to flow type from one column or shape to another and wrap 
type automatically around objects in its path. “With the addition of the Adobe Type Manager software, which is 
included with the Adobe Illustrator program, you can create editable outlines from typefaces.” (Adobe Type 
Manager 2.0 is bundled with Illustrator 3.0.) Type Manager not only smooths screen fonts, but 2.0 helps with 
ImageWriter output.
New Tools

(1) toolbox illustration
There is a whole collection of new tools that appear as pop-out extensions when you point to a tool and hold 

down the mouse button. There are two additional selection tools, the direct-selection tool for selecting anchor points 
or objects without ungrouping them, and the object selection tool which lets you automatically select an entire path 
when you select any part of it (you do not need to hold down the Option key). There are two zoom tools (in and out).
In addition to the basic rectangle tool, there are three additional rectangle tools (centered rectangle, rounded-corner, 
centered rounded corner). These rectangle tools do not require the Option key or a dialog box (although those are 
still available). An additional oval tool (the centered oval/circle) lets you draw ovals from the center without using 
the Option key. 

There are nine transformation tools: The scale tool and a new scale-dialog tool enlarge or reduce objects, 
uniformly or non-uniformly; the rotate tool and a new rotate-dialog tool rotate objects at any angle (360 degrees) 
clockwise or counterclockwise; the reflect tool and a new reflect-dialog tool create mirror images of objects along 
any axis (both positive and negative angles); a shear tool and a new shear-dialog tool slant (skew) objects in any 
direction (shear angles are calculated clockwise); and the blend tool creates intermediate colors, shapes, or both 
between two paths. The scale-dialog, rotate dialog, reflect-dialog, and shear-dialog tools let you specify parameters 
for scaling, rotating, reflection and shearing in dialog boxes without needing to hold down the Option key (although 
you may still use that method). 

There are three new path adjustment tools. The add-anchor-point tool adds an anchor point to a path. The delete-
anchor-point tool removes an anchor point from a path. The convert-direction-point tool changes an anchor point 
from a corner to a smooth point, or from a smooth to a corner point.
New Menus/New Commands



In addition to the new tools are new menu commands and options in the dialog boxes. There is a Move 
command in the Edit menu that brings up a dialog box for pin point accuracy in moving. The Arrange menu contains
four new commands. The Make Guide and Release All Guide commands let you turn graphic objects into guide 
objects. These help you align design elements/objects. Set Cropmarks and Release Cropmarks commands (yeah!!) 
allow you to create crop marks in the program or to control the bounding box information generated for Adobe 
Separator (color separation).

The View menu contains three new commands. Preview Selection (to preview just a selection from an artwork 
document, rather than the entire document), Hide Unpainted Objects and Show Unpainted Objects (hide or show 
any objects that are neither filled nor stroked (outlined)). 

The Paint menu is new and has two commands that let you create and release compound paths (“defining an 
object as a compound path allows to you create objects with holes in them”).

(2) compound path illustration
The Type menu is also new and contains the Style, Font, Size, Leading, Alignment, Spacing Options, Tracking, 

Link, Unlink, Make Text Wrap, Release Text Wrap, and Create Outlines commands.
There is a new menu for Graphs which contains the Graph Style, Graph Data, Use Column Design, Use Market 

Design, and Define Graph Design commands. These let you manipulate graphs and the data they represent, but more
about that later.

The Adobe Illustrator 3.0 program lets you print drafts on non-PostScript printers. I have not, however, had the 
chance to evaluate the quality of the results. Do please note that the references do say “draft.” Also listed as new 
features are additional options in the Preferences, Save As, Page Setup, Paint Style, and Type Style dialog boxes. 
You can now create a startup file to store fonts, patterns, custom colors, and graph designs that you use frequently. 

There is a feature listed for experienced PostScript users called the Adobe Illustrator EPSF Riders file. This file 
can be used to store PostScript fragments used to customize your documents. For example, you can insert a logo so 
that it appears on all documents. There is a cautionary note that this file should not be used if you are not 
experienced.
Page Layout

“Illustrator 3 may still be the more efficient way of producing a lot of ordinary work in a general design studio
—pieces like folders, invitations, business reply cards, letterhead sets, small posters, covers and so on.” (Step-by-
Step) There are three formats available. One gives you a layout of six single pages for tiling, and one is a single page
(each surrounded by a pasteboard). The third format lets you stretch out over the entire imageable area.

You can create a path (a circle, for example) and fill it with text, which will wrap at the boundaries. The paths 
can be irregular in shape and can be linked. There are, however, no spell check or search-and-replace functions 
(large blocks of text should be prepared elsewhere and imported). Tracking and kerning are available along with 
direct width controls.
Enhanced Typographic Tools

Personal Publishing says “The program’s most wide-ranging improvements come in the area of type handling.”
and Tinkel of Step-by-Step says “Illustrator 3 has most of the typographic bells and whistles of PageMaker, 
DesignStudio and QuarkXPress and then some.” Tinkel rates the “hung punctuation” as the greatest new addition to 
the typographic tools. From the professional level, I am sure she is right. This is the ability to set centered headlines 
with hanging punctuation (not calculated when centering).

Text on a path is a feature that a sophisticated graphics program can’t live without. My personal opinion is that 
being able to work with text directly on the page without switching back and forth between the document and a 
dialog box and being able to see the results as you work is the greatest improvement here. Just draw a line or shape, 
choose the text-on-a-path cursor, click on the line and begin typing. Kerning and tracking controls adjust to 1/1000 
em. All the standard type controls are available, including size, leading, alignment and spacing. You can move type 
above or below its 



baseline by specifying vertical shift. The horizontal scale of text in a text object can be adjusted by a value of 
100 percent.

(3) horizontal scale illustration
The Create Outlines command in the Type menu lets you turn any text object or objects into a set of paths that 

you can edit and manipulate as you would a graphic object. A letter converted into an outline becomes a compound 
path. A compound path lets you see through a opening, or a hole, in the path. These outlines can be modified to 
create logos, masks and so forth. Your imagination and skill appear to be the only limits.

(4) black & white illustration
Graphs

Yes, Graphs! Illustrator 3.0 provides six new graph tools. You can choose from Grouped Column (the default), 
Stacked Column, Line, Pie, Area and Scatter Graphs. You create a graph by drawing a basic outline of the graph 
with one of the graph tools or by entering specific dimensions in a Graph dialog box, then either enter data manually
or import data from other programs, files or graphs. The Graph Data window contains options for transposing data, 
for switching the x and y axes in scatter graphs and for adjusting cell column width and decimal precision. Using the
Graph Style makes it easy to change from one type to another to experiment and decide which graph best illustrates 
your data. The Graph Style dialog window lets you choose the attributes for the graph you have chosen (i.e., column
or cluster width, axis orientation, drop shadows, legends, etc.).

(5) graph illustration
Graphs can be customized with graphics and color, or you can edit and enhance a graph using transformation 

tools. “…a graph is a grouped object that is related to its data. You must therefore select the parts you want to edit 
without ungrouping the graph: to do this, use the direct-selection tool. You can create custom markers or columns, 
and also use the designs included on the Gallery disk included with the program. You need to have a certain 
understanding of the relationships involved in displaying your data, but with that restraint, your imagination and 
skills are the only limits.
Graphics

Those of you with drawing experience would not need to do more than scan the sections on the drawing tools 
and descriptions. But I would most sincerely recommend your taking the time to glance over these sections. The 
new tools materially affect nearly every drawing tool available and you will be pleased with their ease of use and 
versatility. You can perform most functions in three ways –– the tool boxes, the menus and the keyboard.

Layering is discussed in respect to Painting. The Adobe Illustrator program paints your work by applying 
successive layers of opaque paint to objects. The order in which the program applies layers of paint corresponds to 
the order in which objects are layered in your artwork. Also, the direct-selection tool does let you select objects and 
paste them in between the layers of existing groups. This was one of the very few aspects of 3.0 about which I heard 
criticism. Layering is an intricate and important function and I read/heard several comments to the effect that this 
was a weak point and, hopefully, the subject of future upgrades.

My loudest praise must go to Adobe’s tutorial manual and samples/templates. As I said in the introduction, I 
started this review by working my way through the tutorial. I was neither bored nor intimidated. Nothing was 
assumed and the steps for each feature were logical and concise. I even got the hang of Bezier Curves. For those 
who are not up on all the graphics vocabulary, these are curves named after Pierre Bezier, that are defined 
mathematically by four control points. “These control points are the four direction points at the ends of the two 
direction lines that are tangent to each curve.” (Huh? Believe me, the examples are more easily understood than 
these words.) All curves in Illustrator are such curves. The tutorial patiently walks you through all the drawing tools 
necessary to construct your graphics. Then “on your own” assignments are suggested and some questions with 
answers attempt to cover the most common problems encountered.

Becoming proficient with this program would take many hours, but you can get going very shortly after you 
finish the tutorial. A few of the procedures will take 



repetition and practice. I was pleased the tutorial gave me several things I could do on my own. Normally, 
following the neatly outlined steps in a tutorial is one thing, but attempting something on your own is an altogether 
different adventure. There is a handy Quick Reference card with most of the procedures outlined briefly. I think I 
will just hang it on my wall.
Manuals

In addition to the tutorial, is the familiar User Guide. This is a thick one. Each section starts with short 
descriptions and definitions, then goes on to handle all the various attributes in detail. I’m sure there may be some 
sections that may never be read, but there are a few that will probably get a lot of use. There is a companion Color 
Guide which will be of use particularly to those who do professional graphics, preprint, desktop publishing and 
presentation graphics. It takes you through preparing your artwork, creating colors with Illustrator (process, custom, 
Pantone matching), working with a color monitor, overprinting, trapping separating (Adobe Separator is included) 
and other specialized techniques, and preparation of your files for use by an imagesetting service.

There is also a little manual entitled “Beyond the Basics”, which is a catalog of advanced techniques and 
strategies for using the program. It is a collection of tips and techniques. If you are a seasoned Adobe Illustrator user,
you can probably start working with some of these immediately. If not, a run through the tutorial and a bit of 
practice will put you in a better position to appreciate these. This little booklet is stuffed with ideas and tricks. 
To Summarize

This a powerhouse program. I have only been able to give you a quick look at the features and improvements of
Adobe Illustrator 3.0. It would be extremely difficult to give a truly detailed review of such a complex application, 
so I have tried to provide an overview of most of the functions (new and old). Adobe has set a very high standard for
other related programs to match. It most definitely is not a lightweight. Being able to integrate serious graphics with 
page layout on the same screen is magnificent and I love being able to manipulate type without using text dialog 
boxes.

Another winner is the ability to create editable outlines from type that can be manipulated to create logos, etc. I 
believe Adobe has taken a giant step toward integrating graphics and text handling capabilities. This package is a 
must for any graphics professional, advanced desktop publisher or serious hobbyist. As I learned this weekend at the
Graphics presentation given by Rick Burress of Artistec (a true Mac expert) and Gary Fields (our own AMUG 
newsletter editor and graphics expert), Adobe  has in Illustrator the only pure PostScript package on the market. 
Currently, Adobe Illustrator 3.0 lists at $595 retail.


